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⭐What Is TeacherMade?⭐
TeacherMade is an online education app that transforms your static PDFs and turns them into digital interactive worksheets. They’re easy to 
make and much more popular with your students (and their parents ;). As a result, the best materials that you've created over the years can 
take center stage in your digital classroom.

The TeacherMade app works just like you do. When you use it, you’ll: 

● Upload PDFs and other file types (instead of going to the copy room ;)
● Create/Edit these “PDF worksheets” by making them interactive with the magic TeacherMade tools
● Organize your activities into folders
● Share your activities with other Teachers
● Assign activities to your students
● Grade student work (with autograding!) and return it with feedback 

         Section 1: What Can You Do With TeacherMade?

“Using TeacherMade with the myPerspectives text set was so much more efficient than opening individual docs and going in and 

out of students' files in Google Classroom. With the extra time I had to myself at the end of the day, I was able to start and 

actually finish a novel of my own choosing! For adults! I  haven't been able to do that in over a decade.  Thank you, TeacherMade.”

— M. Percontino, NJ



⭐What will you learn in this training?⭐ 
This Professional Development Module addresses uploading of a PDF and turning it into an interactivity. This is the heart of 
TeacherMade where you’ll find so many tools and features—the only limit will be your imagination!

              Please click on the image below to view the video.

https://docs.google.com/presentation/d/18QCB5CWtn1GN0ZoMoatxEYkhMfmwb6sNq7jnLlAabhA/edit?usp=sharing
https://docs.google.com/presentation/d/18QCB5CWtn1GN0ZoMoatxEYkhMfmwb6sNq7jnLlAabhA/edit?usp=sharing


⭐Let’s Get Started!⭐
Before we can begin our deep dive into TeacherMade, you will need to download the Sampler worksheet. You’ll use it to practice with the 
TeacherMade tools and features you’ll be reading about. 

1. Download the TeacherMade Sampler.pdf by clicking on THIS LINK. 
2. Download and save this file to your desktop by:

a. Dragging the file over from your download bar and dropping it onto 
your desktop. 
-OR-

b. Right-click on the file name and select Download from the pop-up 
menu.

Once you have your TeacherMade Sampler 

PDF saved to your device, it’s time to upload 

it into the TeacherMade app. On the next 

page, we will log into your TeacherMade 

account. 

https://docs.google.com/document/d/1DjA2NEDWUUX-zztMvI0udu64ndCdsY5KqjLKLVa_l4k/edit


⭐How to Create Your TeacherMade Account⭐

         Section 2: Creating Your Account 

Click here for detailed instructions 
if you need to create an account.

➔ Visit https://www.teachermade.com and click the "Login/Return to 

APP" link in the upper right corner.

➔ Enter your username and password, or use the convenient "Sign In 

With Google" link if you're set up for that.

➔ You will land on the splash screen that always alerts you to new 

information and updates. Take a look!

➔ Click “Continue to My Account.”

https://docs.google.com/document/d/1sVRL5bAgJ4AjoCB-JL5PmCQERuHaFAjeCuYx2I1hOsA/edit?usp=sharing
https://www.teachermade.com/


⭐Create a New Interactivity⭐
After you login, you should be on your TeacherMade home page, something we like to call the Digital File Cabinet. It's where you see a 

list of all of your activities. 

● Click the green “+” sign next to New Activity

● You will have two choices. You can upload a document or create a blank activity from scratch.

         Section 3: Creating/Uploading Your Activity

➔ We are going to build activity from an existing PDF, 

so click "Upload a File."

➔ Choose the “Sampler PDF” file you downloaded to 

upload from your computer.

➔ You can also just drag the file and drop it onto the 

Upload a File option to begin uploading.



⭐Choose Your Pages⭐
The computer will quickly process your file, then you'll need to choose the pages from the file you want to use in your activity.

● Choose the pages from the thumbnails by clicking each page you want to include.

● You can choose all by clicking the checkbox "Select All" at the top of the list.

● The pages you choose will be checked and highlighted in blue.



⭐Choose Your Display Type⭐
Next, you can choose how you want the activity to display to your students.

To choose the display type and finish creating the activity:

● Click either "Scrolling" or "Slides" under "Display Style."

● Choose “Slides”
● Your choice will be highlighted in blue.

● Click the "Create Activity" button.

TeacherMade will create your new activity and open it in the Activity Editor for you.

Scrolling
The Scrolling Display Style joins all the pages into a single scrollable view. The 
pages are scrolled continuously in the order they appear in the uploaded 
document. This is a good choice for materials where you want to eliminate 
page breaks, or for students who struggle to navigate through paged 
materials.

Slides
The Slides style display will show the pages one at a time to the student. The 
student will interact with one slide, then navigate to the next one. This is a 
great choice if you wish to mix instruction and practice into a single lesson. 
You'll also be able to add slides, re-order them, or even add slides from 
different PDF files.



⭐Name Your Activity⭐
You will need to give your activity a title.

● Click “Untitled Activity."

● A pop-up will appear. 

● Enter the title of your activity.

● You can also add a “Description” to your activity.

● Click "Save."

⟹ The steps above work for any file that you want to upload into TeacherMade. 

Quick Tips:
● You can upload any PDF, DOCX, JPG, PNG, or GIF file.
● You can upload up to 25 pages at a time with a TeacherMade PRO account. 

⭐Your Turn: Follow the instructions above and upload the “TeacherMade 
Sampler PDF” into your TeacherMade account. *Be sure it’s in Slides Display.



⭐Add a Tool to Your Interactivity⭐
Now that you’ve created a new activity in TeacherMade, how do you add auto-scored interactions (tools)? It couldn’t be easier! 

On your Edit Activity screen, there are two ways to insert a tool:

1. Click directly on your activity where you want the tool to be; or

2. Click  “Insert”  on the Toolbar. 

Either way, when you release the mouse button, a pop-up menu will appear. Here you will find all of the tools TeacherMade has to offer! 

*Drawing an answer area and then editing its properties is the basic workflow on the Edit Worksheet screen. 

Insert an answer box, then Edit its properties. Insert, then Edit. Insert, insert. Edit, edit.

         Section 4: Question/Math Tools to Add to Your Interactivity



    

Video Cheat Sheet: Directions on How to Use Each of the Tools

Algebra Expression

Fraction

Mixed Number 

123 Number Choice

Checkbox/Multiselect

Drop Down

Matching

Inline Choice

Drop Zone

Hot Spot

Hot Text

Match Table Grid

Multiple Choice

Open Answer

True/False 

Short Answer 

https://docs.google.com/presentation/d/1QV3vWIF4UVvy81Qf1F3FZo20X7un72yThOOrrKhaU5M/edit?usp=sharing
https://docs.google.com/presentation/d/1g6BfpJdHuUr23orzCgVuFi1b3chbOy5HXthiPlQ1BFI/edit?usp=sharing
https://docs.google.com/presentation/d/1Vr2kVnEcdp5hRh6gOFJGXZ-eq6iQq-Ee_20x8PnJUbg/edit?usp=sharing
https://docs.google.com/presentation/d/1Atmx9N8YAyO_e8U2MSokdl4z1NZ2_AfcuNvDt1BMN_c/edit?usp=sharing
https://docs.google.com/presentation/d/1DJmgb0eRMm6_s1fas491-sKMoYB1KMku33gPEsgGAX0/edit?usp=sharing
https://docs.google.com/presentation/d/1l4_QkM61aJUTR3muEy4PSzzXTw1a4IR9u29Uf-NBaoY/edit?usp=sharing
https://docs.google.com/presentation/d/1lbAiSX_WD7GVAgLqyMqSEpfmdNHiPZBbwE3xriCisnY/edit?usp=sharing
https://support.teachermade.com/support/solutions/articles/72000583718-how-do-i-use-the-inline-choice-tool-
https://youtu.be/V-xtOfoHJE0
https://docs.google.com/presentation/d/1P4P57b5MXW76RnSMVyzFguTmJ_-gxQ9Rb3_EUsnx5ss/edit?usp=sharing
https://support.teachermade.com/support/solutions/articles/72000593647-how-do-i-use-the-hot-text-tool-
https://support.teachermade.com/support/solutions/articles/72000593648-how-do-i-use-the-match-table-grid-tool-
https://docs.google.com/presentation/d/1TSXDFQJs3Oik4wcHoEQb9nb7YISn-GjaGQ-MtdHHJDQ/edit?usp=sharing
https://docs.google.com/presentation/d/1oaRtvInbbE1eLr2kOGouAdoWQHVVNApNJ2pwVhScIuI/edit?usp=sharing
https://docs.google.com/presentation/d/1abBGgo54Zgs1Ap6V9BU7YANSvcuRU8Hw7jUPmGIR538/edit?usp=sharing
https://docs.google.com/presentation/d/1rPfRJAV_FgZB7_T1Ua6raplJnN07WWq3HkyNlLdoWSw/edit?usp=sharing


⭐Question Tools: Checkbox/Multiselect⭐
★ Checkboxes/Multiselect Video: Click Here

This tool is similar to Multiple Choice, but with an important difference: the student must select ALL of the correct answers to get it right, 
whereas with Multiple Choice questions they only have to pick one of the answers. Use this tool when students need to select two or 
more correct answers from a list of answer choices, as they frequently need to do on state tests.  

How to Use: 
1. Select “Checkbox/Multiselect” from the pop-up menu.
2. The checkboxes will be added to the activity, and the toolbar will show the options for the Checkbox/Multiselect item.

These options will allow you to change:
● The amount of checkboxes (1 – 8)
● The transparency of the checkbox
● The point value of the item
● Limit the number of student selections

3. Click the box next to the correct answer(s).
4. It will look like this when you are done!

► Pro Tip: Checkboxes can be oriented in either direction—top to bottom or left to right. To change the orientation select the item and resize using the 
blue boxes on the corners of the multiselect.

Your Task: Complete the “Checkbox” exercise on       Page 1 of your TeacherMade Sampler.

Auto-Graded ☑  

Ctrl-D ☑

https://youtu.be/ha4cvWOgAgQ


⭐Question Tools: Dropdown⭐
★ Dropdown Video: Click Here

This question type provides multiple answer choices in a drop-down list for your students to select from. This tool turns any fill-in-the-blank or cloze 
activity into a technology-enhanced item, just like those on your state test.

How to Use: 
1. Select the “Dropdown” on the pop-up menu, then click down on your assignment.
2. The “Edit Short Dropdown’’ box will appear. 
3. Type in the correct answer and choose the number of points.

Note: You can insert up to 10 answer choices and choose one correct answer. 
On this pop-up you can also:

● Choose the point value
● Use a Shortcut (ABC, ABCD, 123, etc.) to create answer choices
● Shuffle the order of the answer choices

4. Click “Save Changes.”
5. It will look like this! 

 
► Pro Tip: 

● This question type can be auto-graded, and you can also use Control + D to duplicate the dropdown.
● Dropdowns can easily be substituted for multiple choice questions to break up the monotony!

Your Task: Complete the “Dropdown” exercise on       Page 1 of your TeacherMade Sampler.

Auto-Graded ☑  

Ctrl-D ☑



⭐Question Tools: Drop Zone (Drag and Drop)⭐
★ Drop Zone Video: Click Here

This tool allows you to take many of your standard exercises and turn them into gamified digital activities that your students will love! There are two 
many ways to use Drag and Drop: labeling and categorization.

       How to Use: 
➔ Step 1 - Create a Drop Zone:
1. Select “Drop Zone” from the pop-up menu. Draw your Drop Zones, or “targets,” in your activity.
2. It will look like this!
3. Select a Drop Zone box and the Options bar will display under the tool bar.

● By default, teachers can only attach one draggable item to each Drop Zone. 
This works well for labeling activities like in the plant example above. 

● When “Allow multiple items” is unchecked, the dragged items will “snap” into place when students drop them on the zone. When “Allow 
multiple items” is checked, the object will remain where placed by the student. (If you are creating a categorization worksheet, you would 
check this box). 

➔   Step 2 - Create a Draggable Item:
4. Next, make some items “draggable” so the student can drag them to drop zones. There are three kinds of “draggable items” in TeacherMade:

a. Those that you added to your worksheet using the “Image” or “Teacher Text” Tools 
➢ Just click “Draggable” on the Options bar after you add them to your interactivity. 

b. Things that are already a part of your worksheet that you want to make draggable.
➢ Use the “Snipping tool” to copy the item and drag it to where you want it to be. Click the “Draggable” option. 

c. Objects that you snip from other TeacherMade activities and paste into your current one. 
➢ Open the other activity where the desired object is located. Click the scissors icon to use the Snipping Tool. Draw a

rectangle around the desired object and select “Copy” from the Edit menu (or use Ctrl-C). Click on the activity in which
you want to use the snipped item and use Ctrl-V or select “Paste” from the Edit Menu.

Auto-Graded ☑  

Ctrl-D ☑

https://docs.google.com/presentation/d/1P4P57b5MXW76RnSMVyzFguTmJ_-gxQ9Rb3_EUsnx5ss/edit#slide=id.p


⭐Question Tools: Drop Zone (Continued)⭐
➔ Step 3 - Connect the “Draggable” item(s) to the Drop Zone(s):
1. Click one of your snipped “draggable” objects to select it. 
2. Shift-click the matching Drop Zone for the draggable item. A blue line will appear between the object and the zone. 
3. Continue until each draggable item is matched to the correct Drop Zone.
4. Your worksheet will look like this!

How to Detach a “Draggable” item(s)

1. Select the item you want to detach and click on the “Clear Link” on the Options Bar. 

How to Change the Drag and Drop’s Point Value for Autograding

1. Select one of the draggable items. By default, it will be worth 1 point.
2. Click the green value box and choose a new point value from the drop down menu.

► Pro Tip: You have the option to:
●Add or remove the border around each of the individual draggable items.
●Change the color of the borders.

    Your Task: Complete the “Drop Zone” exercise on       Page 2 of your TeacherMade Sampler .

Auto-Graded ☑  

Ctrl-D ☑



⭐Question Tools: Hot Spot⭐
★ Hot Spot Video: Click Here

This tool will allow you to designate areas of your interactivity as correct areas and others as incorrect. Students must click on the correct areas but 
should not click on the incorrect areas. These areas can be pictures, words, sentences–anything that you need!

How to Use:
1. Select “Hot Spot” from the pop-up menu. Drag a box around the first area that will be clickable by the student as a possible answer.
2. Continue drawing these boxes until every possible “answer-choice area” has a box. (We call these areas “Hot Spots.”)
3. You can score whether or not each hot spot was clicked individually, or you can create a group for the hot spots to be scored altogether as one 

item. To create a group, shift-click on every hot spot you wish to include in the group.
4. Click on a single hot spot and then select the “Edit Hot Spot” button on the toolbar. (You can select some choices directly on the toolbar.)

 
a. You have the option to select, “The student should click this hotspot” or “The student should leave this hotspot unclicked.” 
b. Repeat for each hot spot in the group.
c. The question can be worth up to 10 points.

5. It will look like this! 

► Pro Tip: You have the option to:
●Add or remove a border around each of the individual hotspots.
●Change the color of the borders.
●Make the corners of the hotspots rounded.

Your Task: Complete the “Hot Spot’’ exercise on       Page 2 of your TeacherMade Sampler.

Auto-Graded ☑  

Ctrl-D ☑

https://docs.google.com/presentation/d/1P4P57b5MXW76RnSMVyzFguTmJ_-gxQ9Rb3_EUsnx5ss/edit#slide=id.p


⭐Question Tools: Hot Text⭐
★ Hot Text Video: Click Here

The Hot Text tool will present students with a text passage that has clickable words, phrases, or sentences. They must decide which of the clickable 
parts meet the criteria in your question and select them to indicate their answer.

How to Use: 
1. Select “Hot Text” from the pop-up menu. 
2. This pop up will appear. 
3. Click the box labeled “Write text here” and enter your text passage in its entirety.
4. Highlight the words that you want to be clickable as answer choices. 
5. In the box that appears, click the checkbox next to the words “Hot text.”

Repeat this process for other words or phrases you wish to make clickable.
6. Each word(s)/phrase(s) will appear in a list below the text with a blank checkbox beside it. 
7. Select the checkboxes to the left of each word/phrase that should be selected by students.
8. Click “Save.”
9. It will look like this! 

► Pro Tip: 
● Turn on the “Limit number of selections” switch at the top of the editing box to prevents students from selecting more than the number of

correct answers. 

Your Task: Complete the “Hot Text” exercise on       Page 3 of your TeacherMade Sampler.

Auto-Graded ☑  

Ctrl-D ☑



⭐Question Tools: Inline Choice⭐
★ Inline Choice Video: Click Here

The Inline Choice item lets you add drop-down questions in the middle of a text passage. Your students will be given a choice of options to choose from 
the drop-down menu that correctly fits in the text. 

How to Use: 
1. Select “Inline Choice” from the pop-up menu. Draw a box on your assignment.
2. This pop-up will appear. 
3. Start typing your sentence in the box labeled “Write text here.”
4. When you get to a spot where you want to  place a drop-down menu, click “Add Dropdown.”
5. Add each of the choices you want in the drop-down menu at the bottom of the box.
6. Select the correct answer choice by clicking the radio button on the left:

 

7. You can remove any choice by clicking the “X” to the far right of the answer.
8. Continue typing your text and adding drop-downs as desired. Click on “Save” when you have finished.
9. It will look like this! 

► Pro Tip: 
●The drop-downs are automatically sized to accommodate the longest answer choice in that drop-down menu.
●Students will need to select the correct choice in all of the drop-down menus in the item correct to receive the points for the question.

Your Task: Complete the “Inline Choice” exercise on       Page 3 of your TeacherMade Sampler.

Auto-Graded ☑  

Ctrl-D ☑



⭐Question Tools: Matching⭐
★ Matching Video: Click Here

This feature allows students to match pairs of correct answers by drawing a line to connect them. 

How to Use: 
1. Select “Matching” from the pop-up menu.
2. Then draw boxes around each choice (they will turn red). 
3. Hold down the “Shift” key and click on two choices to match them as correct answers (they will turn

green and show a dotted line connecting the pair). 
4. Don’t worry if you make a mistake. Hold down the Ctrl key while clicking to undo the match or just

shift-click on another answer choice.
Note: Students can only match each option with one answer.

5. It will look like this! 

*On the toolbar, you can assign a point value by clicking on “Edit…” or choosing the “Item Points.”

 
► Pro Tip: 

● Use Control + D to duplicate the matching box and drag them onto each answer choice. Or, after drawing one box, hit the spacebar and draw 
another, especially if the boxes need to be different sizes.

● Make the border invisible on the matching boxes, by clicking on the         on the toolbar and selecting “No Border.”

Your Task: Complete the “Matching” exercise on       Page 4 of your TeacherMade Sampler.

Auto-Graded ☑  

Ctrl-D ☑

https://docs.google.com/presentation/d/1lbAiSX_WD7GVAgLqyMqSEpfmdNHiPZBbwE3xriCisnY/edit#slide=id.p


⭐Question Tools: Match Table Grid⭐
★ Match Table Grid Video: Click Here

A Match Table Grid item consists of a table with rows representing the questions and columns representing possible answers. Each cell in the table 
represents a “match” between the corresponding row and column. It’s an efficient way to ask a series of multiple choice or multi-select questions with 
the same answer choices.

How to Use: 
1. Select “Match Table Grid” from the pop-up menu. Click where you want the item on your activity.
2. This pop up will appear 
3. Add labels to the grid.

● The header row is for answer choices.
● The leftmost column is for question prompts.

4. Add more columns or rows if needed by selecting the “+” signs.
5. Delete rows and columns by selecting the “x.”
6. Select the cell that represents a “match” or correct answer for each row.

● If you there is only one correct answer per question,  do not check the box for “Can
have multiple correct answers per row.” Each cell will contain a “radio” button. 

● If you check “Can have multiple correct answers per row,” each cell will contain a checkbox. 
7. Click “Save.” It will look like this! 

► Pro Tip: If your Match Table Grid is too large: 
●Try reducing the font size and then resizing the box. 
●Use the “Preview” button in the editor to ensure everything is displayed correctly.

  Your Task: Complete the “Match Table Grid” exercise on        Page 4 of your TeacherMade Sampler.

Auto-Graded ☑  

Ctrl-D ☑



⭐Question Tools: Multiple Choice⭐
★ Multiple Choice Video: Click Here

The Multiple Choice tool enables students to choose one answer out of up to 8 possible choices, aka “distractors.”

How to Use: 
1. Select “Multiple Choice” from the pop-up menu.
2. The bubbles will be added to the activity, and the toolbar will show the options for the Multiple Choice item.

These options will allow you to change:
● The number of answers that will count as correct (but students can only choose one)
● The letters or numbers in the bubbles
● The transparency of the multiple choice box
● The point value of the item
● The orientation of the bubbles (4x1 or 2x2)

3. Click the bubble next to the correct answer, or you can choose more than one by using the shift key when you click.
4. It will look like this when you are done!

► Pro Tip: You can resize and orient the multiple-choice bubbles horizontally or vertically. 
◆ Select one of the corners of the box, then drag it up, down, left, or right.
◆ The box will automatically switch its orientation and resize the bubbles.

      Your Task: Complete the “Multiple Choice” exercise on       Page 5 of your TeacherMade Sampler.

Auto-Graded ☑  

Ctrl-D ☑

https://docs.google.com/presentation/d/1TSXDFQJs3Oik4wcHoEQb9nb7YISn-GjaGQ-MtdHHJDQ/edit#slide=id.p


⭐Question Tools: Open Answer⭐
★ Open Answer Video: Click Here

This question type is meant for longer answers that cannot be auto-graded, like essays and writing prompt responses.

How to Use: 
1. Select the “Open Answer” on the pop-up menu.
2. It will look like this!
3. With your box selected, you can change the border, font, color, and size of the student’s response on the status bar. The toolbar will show your 

options for the Open Answer Tool. 

4. Optional: 
● You may add a starter sentence or hint by clicking on the blue “Edit Open Answer” button on the toolbar. Your text will disappear as the student 

types.

● You can assign a point value to the Open Answer on the toolbar.

► Pro Tip:
●Students will be able to keep typing regardless of the size of the box. 
●The app will create a scrollable window so you can see all of their words. 

     Your Task: Complete the “Open Answer” exercise on       Page 5 of your TeacherMade Sampler.

 Ctrl-D ☑

https://docs.google.com/presentation/d/1oaRtvInbbE1eLr2kOGouAdoWQHVVNApNJ2pwVhScIuI/edit#slide=id.p


⭐Question Tools: Short Answer⭐
★ Short Answer Video: Click Here

This tool is meant for short one to several-word answers (also called “Fill-in-the-Blanks”) and can be auto-graded. You can only see the words that fit in 
the physical box. (Students will not be able to indent or type long paragraphs. Use the Open Answer tool for those activity types.)

How to Use: 
1. Select “Short Answer” on the pop-up menu, then click down on your assignment.
2. The “Edit Short Answer” box will appear. 
3. Type in the correct answer(s) and assign points. 

● Select “Do not score” from the dropdown if you do not want the answer autograded.
Note: You can add up to 10 correct answers and give a maximum of 10 points.

● Check the box for “Answers must match the case (upper or lower) to be correct” if you
want to score based on correct capitalization.

● Check the box for “Ignore punctuation marks in student answer” if you DON’T want to 
score based on punctuation.

● Check the box for “Allow partial match in student answer” if you want TeacherMade to match the minimum amount of text required.
4. When you are done, it will look something like this! 

► Pro Tip: If your assignment requires multiple short answer boxes, don’t waste time creating each one from scratch. 
●Select the first box you made by clicking on it.
●Then select Control + D as many times as you need boxes.

■ This will duplicate the boxes and then you can select each one to reposition it. 

Your Task: Complete the “Short Answer” exercise on       Page 6 of your TeacherMade Sampler.

Auto-Graded ☑  

Ctrl-D ☑

https://docs.google.com/presentation/d/1rPfRJAV_FgZB7_T1Ua6raplJnN07WWq3HkyNlLdoWSw/edit#slide=id.p


⭐Question Tools: True/False⭐
★ True/False Video: Click Here

This tool presents the students with two buttons to choose between, such as “True/False” or “Yes/No.” You can even customize the buttons for your 
students! 

How to Use: 
1. Select “True/False” from the pop-up menu.
2. Click on your assignment where you would like to place the tool. The “True/False” box will appear. 
3. Click on the correct answer. The default score will be sent to one point.
4. It will look like this!
5. The toolbar will show the options for the “True/False” tool. 

*Using the toolbar, you can edit the button’s labels to choose from one of the types displayed. 
➔ Selecting “Custom” enables you to create your own labels for the buttons! 

 
► Pro Tip: You can make your “True/False” buttons horizontal or vertical. To change the orientation, select one of the corners of the box, then drag it 

up, down, left, or right.

Your Task: Complete the “True/False’’ exercise on       Page 6 of your TeacherMade Sampler.

Auto-Graded ☑  

Ctrl-D ☑

https://docs.google.com/presentation/d/1abBGgo54Zgs1Ap6V9BU7YANSvcuRU8Hw7jUPmGIR538/edit#slide=id.p


⭐Math Tools:⭐
When you click on Math tools, you will choose one of the following types of problems: 

 Math Question Types 
Use the Math Tools to create answer boxes on your worksheet that are pre-formatted to accept numbers, math symbols, and 

operators. You can pair these with an area for students to show their work by using the “Open Answer” tool.



⭐Math Tools: Algebra/Formula⭐
★ Algebra/Formula Video: Click Here

This tool is used for student responses that require more complex math equations and formulas. When answering, students are provided 
with a math LaTex equation editor that they can use to answer the question. Popular with Math and Science Teachers!

How to Use: 
1. Select “Algebra/Formula” from the Insert menu. Click where you want it to 

appear in your activity.
2. The “Edit Algebra/Formula” screen will appear.
3. Enter the correct answer(s)

● You will be provided with the same LaTex equation editor that students use to input their answers. 
● You can add up to 10 correct answers per question, and each can be worth up to 10 points.

4. It should look like this! 

5. Press the spacebar or select the box and use Ctrl-D to add more “Algebra/Formula” answer boxes.

► Pro Tip: The “Algebra/Formula” tool can also be used for fractions and mixed numbers.

Your Task: Complete the “Algebra/Expression” exercise on       Page 7  of your TeacherMade Sampler.

Bonus exercise: Select the “P/Open Answer” tool and draw a space to the right of the answer boxes where students can show their work.

Auto-Graded ☑  

Ctrl-D ☑

https://docs.google.com/presentation/d/1QV3vWIF4UVvy81Qf1F3FZo20X7un72yThOOrrKhaU5M/edit#slide=id.ge4e6e7d7a5_0_0


⭐Math Tools: Fraction⭐
★ Fraction Video: Click Here

This tool displays two number boxes with a fraction bar in between so that students can enter a numerator and denominator.

How to Use: 
1. Select “Fraction” from the Insert menu. Click where you want it to appear in

your activity.
2. The “Edit Fraction” screen will open. 
3. Enter the correct answer(s). Here you can enter up to 10 correct answers.
4. It should look like this! 

5. Press the spacebar or select the box and use Ctrl-D to add more “Fraction” answer boxes.
 

► Pro Tip: You can use the “Add a correct answer” button to enter any equivalent fractions you want to accept as correct. 

Your Task: Complete the “Fraction” exercise on        Page 7 of your TeacherMade Sampler.

Bonus exercise: Select the “Open Answer” tool and draw a space to the right of the answer boxes where students can show their work.

Auto-Graded ☑  

Ctrl-D ☑

https://docs.google.com/presentation/d/1g6BfpJdHuUr23orzCgVuFi1b3chbOy5HXthiPlQ1BFI/edit#slide=id.p


⭐Math Tools: Graph - Plotting⭐
★ Graph - Plotting Video: Click Here

This tool lets your students practice plotting points or lines on the coordinate plane. It’s a flexible tool that enables you to define the extent 
of the plane, and specify which points or lines students will be required to draw.

How to Use: 
➔ Step 1 -  Insert a Graph: 
1. Select “Graph Plotting” from the Insert menu. 
2. The “Edit Graph - Plotting” screen will appear. 
3. Enter X-Axis and Y-Axis min/max to set the size of the coordinate plane.
➔ Step 2 - Choose Plotting Type: Points or Lines
1. Select “Points” if you want students prompted to plot specific points.
2. Select “Lines” if you want students prompted to draw a line.
3. Choose the amount of points this question is worth when grading.

(Note: Students must correctly plot ALL lines or points for the full score.)
➔ Step 4 - If you chose to prompt students to plot “Points,” set the points for the 

student to plot by:
1. Entering the x and y coordinates of each point in the boxes.
2. Click “Add Point” and the points’ coordinates will be added to the list. 
3. To remove one of the points, click the trash can icon beside its coordinates.

Auto-Graded ☑  

Ctrl-D ☑



⭐Math Tools: Graph - Plotting (Continued)⭐

➔ Step 4b - If you prompt students to plot “Lines,” choose one of the following methods to define each line: 
Method 1 - With Constants

1. To add a line in slope-intercept form (y=mx + b), choose “Constants.” 
2. Enter the value or m (the slope of the line) and b (the y-intercept). 
3. Choose “Add Line” and your line will be drawn on the plane.

Method 2 - With Points
1. To add a line defined by two points, choose “With points.”
2. Enter the x and y values for the two points and the line will be drawn through

those points.
3. The points will also be drawn for your reference and given labels as well. 

► Pro Tips: 
● Make your coordinate plane into a perfect square by clicking on the grid and

holding on the shift key as you drag one of the corner handles. 
● Display just Quadrant I of the Coordinate Plane by entering -1 as the 

minimum value for both the x and y axes. 
● Add Text to your item type by inserting “Teacher Text.”

Your Task: Complete the “Graph - Plotting” exercise on       Page 8 of your TeacherMade Sampler.

Auto-Graded ☑  

Ctrl-D ☑



⭐Math Tools: Mixed Number⭐
★ Mixed Number Video: Click Here

This tool draws answer boxes for the 3 parts of a mixed number—the whole number, the numerator, and the denominator. 

How to Use: 
1. Select “Mixed Number” from the Insert menu. Click where you want it to 

appear in your activity.
2. The “Edit Mixed Number” screen will open.
3. Insert the correct answer(s). You can enter up to 10 correct answers.
4. It should look like this! 

5. Press the spacebar or select the box and use Ctrl-D to add more “Mixed Number” answer boxes.

► Pro Tip: Just as with the “Fraction” tool, you can use the “Add a correct answer” button to enter any equivalent mixed numbers you 
want to accept as correct.

Your Task: Complete the “Mixed Number” exercise on       Page 8 of your TeacherMade Sampler.

Bonus exercise: Select the “Open Answer” tool and draw a space to the right of the answer boxes where students can show their work.

Auto-Graded ☑  

Ctrl-D ☑

https://docs.google.com/presentation/d/1Vr2kVnEcdp5hRh6gOFJGXZ-eq6iQq-Ee_20x8PnJUbg/edit#slide=id.p


⭐Math Tools: 123 Number⭐
★ Number Video: Click Here

This tool creates an answer box that will only accept numeric characters and symbols. 

How to Use: 
1. Select “Number” from the pop-up menu. 
2. The “Edit Number” screen will open.
3. Insert the correct answer(s). You can enter up to 10 correct answers.
4. You can choose to allow or disallow students to use the following in their answers:

i. Commas
ii. Minus/negatives
iii. Decimals 

5. It will look like this! 

6. Press the spacebar or select the box and use Ctrl-D to draw another Number box.

► Pro Tip: You have the ability to change the font, font size, color of the text, and border color of the number boxes. 

Your Task: Complete the “123 Number” exercise on       Page 9 of your TeacherMade Sampler.

Bonus exercise: Select the “Open Answer” tool and draw a space to the right of the answer boxes where students can show their work.

Auto-Graded ☑  

Ctrl-D ☑

https://docs.google.com/presentation/d/1Atmx9N8YAyO_e8U2MSokdl4z1NZ2_AfcuNvDt1BMN_c/edit#slide=id.p


⭐Tools That Bring the Power of Media and URL Links to Your Interactivities⭐
The TeacherMade Menu  gives you access to more than just the different question types. 

You can also use 6 tools to add additional levels of engagement to your interactive worksheet. 

         Section 5: Content Tools



⭐Content Tools: Audio⭐
★ Audio Video: Click Here

This tool enables you to add up to 10 MB of audio, or approximately 5 minutes of recording! 

How to Use: 
1. Select “Audio” from the Insert menu. Click where you want the play

button to appear in your activity.
2. The “Record or Upload Audio” screen will open.
3. To record your audio: 

● Click the red circle to start recording and the gray square to stop. 
● Click “Add Audio to Activity” when you are done. 

To upload audio from your computer:
● Click on the “Upload” tab.
● Click “Browse” to find the file on your computer and upload.

4. A speaker icon will appear on your interactivity. It will look like this! 

► Pro Tip: The “Audio” Tool is a great way for teachers to pronounce vocabulary words or read text to students for listening 
comprehension activities.

Your Task: Complete the “Audio” exercise on       Page 10 of your TeacherMade Sampler.

Ctrl-D ☑

https://docs.google.com/presentation/d/1pLuZyMYSDWnH_f0KFx00UJIpjSHEAnYfqvQe5Gz7L0U/edit#slide=id.p


⭐Content Tools: Color Block⭐
★ Images Video: Click Here

This tool is your best friend when you modify worksheets formerly meant for print. It allows you to draw a rectangle that covers any 
unwanted elements in the original worksheet, such as outdated instructions, answers, etc.

How to Use: 
1. Select “Color Block” from the Insert menu.
2. Draw the Color Block wherever you would like it on your interactivity. 
3. It will look like this! 

►Once it is placed on your interactive worksheet, you can:
●  Edit its size.
●  Move it around.
●  Fill it in with color.
●  Add a border and set its color.

Note: Choosing a fill color and border that matches the background (such as white) is popular for making the color block 
completely invisible to the student.

► Pro Tip: If your uploaded PDF includes answers to the questions, you can place a color block over these answers, so that                       
your students cannot see them!

  Your Task: Complete the “Color Block” exercise on       Page 10 of your TeacherMade Sampler.

Ctrl-D ☑

https://docs.google.com/presentation/d/1VUy3er-7wdsvHsdQISDK8jW6d9mlXUSllxGBObqkpVY/edit#slide=id.p


⭐Content Tools: Image⭐
★ Image Video: Click Here

This tool enables you to add images to your worksheet. Your students won’t be able to delete or move these images. 

How to Use: 
1. Select “Image” from the Insert menu. Click where you want it to appear in

your activity.
2. The “Add an Image to the Activity” screen will open.
3. Choose an image from your computer that you would like to add to your Gallery.
4. It will upload to your Gallery and automatically display in the box on your interactivity. 
5. It should look like this! 

► Pro Tip: You have the option to:
○ Resize the box.
○ Color the border.
○ Lock the aspect ratio.
○ Make the background transparent.

Your Task: Complete the “Image” exercise on        Page 11 of your TeacherMade Sampler.

Ctrl-D ☑

https://docs.google.com/presentation/d/1VUy3er-7wdsvHsdQISDK8jW6d9mlXUSllxGBObqkpVY/edit#slide=id.p


⭐Content Tools: Video⭐
★ Video Video: Click Here

This tool enables you to add embedded videos directly into your TeacherMade activities! Your students will no longer have to toggle 
between multiple screens.

How to Use: 
1. Select “Video” from the Insert menu. Click where you want it to appear in

your activity.
2. The “Video” screen will open.
3. Select how the video will be displayed to students in your activity: 

● Inline: This option will display the video directly on your slide as a thumbnail. Use this when you have space in the document and 
want the student to always see the video. The video plays in the box you drew, and students can choose to watch it using their full 
screen, too.

● Floating: A “Floating” video doesn’t play in the box you drew, but instead plays in a floating window that students can move. Use this 
when there’s no room on the activity for a video box, or if you want the students to be able to scroll through an activity and still see 
the video playing. When you add a floating video, you’ll position a “Watch Video” button that students will click to start the video.

4. Paste the URL of the video into the provided field. TeacherMade supports most public video streaming services and also direct links to video 
files stored in publicly accessible servers. It does not currently support links from Google Drive.

► Pro Tip: When using the Inline option, you can resize the video by dragging the corners of
           the thumbnail.

Your Task: Complete the “Video” exercise on       Page 11 of your TeacherMade Sampler.

Ctrl-D ☑



⭐Content Tools: Links⭐
★ Links Video: Click Here

Use this tool to insert URLs or links to Google Docs, Google Slides, etc., into your TeacherMade activity.

How to Use: 
1. Select “Links” from the Ithe Insert menu. Click where you want it to

appear in your activity.
2. The “Edit Link” screen will open.
3. Enter the actual address of the link you would like to hyperlink.

➔ You must include http:// or https:// as part of the URL address.
4. Enter an optional label that will display inside of the box for your students to see instead of the URL.
5. It will look like this! 

► You have the option to edit:
●The color of the border around the box and the words in the box.
●The font and font size.
●Whether the box is transparent or solid.

► Pro Tip: We suggest previewing this page to ensure the hyperlink is easy for your students to recognize. When your students click on 
the link, the website, slide, or document will open in a new browser tab.

Your Task: Complete the “Links” exercise on       Page 12  of your TeacherMade Sampler.

Ctrl-D ☑

https://docs.google.com/presentation/d/1pLuZyMYSDWnH_f0KFx00UJIpjSHEAnYfqvQe5Gz7L0U/edit#slide=id.p


⭐Content Tools: Teacher Text⭐
★ Teacher Text Video: Click Here

This tool enables you to add text directly to your interactive worksheet. This is perfect for adding instructions, hints, and reminders for 
your students as they complete their work.

How to Use: 
1. Select “Teacher Text” from the Insert menu. Click where you want it to appear

in your activity.
2. The “Edit Text” screen will open.
3. Enter your text.

● You are able to change the style, Font, Font Size/Color, and Fill Color.
● Click “Transparent” for the Fill Color if you want the background from the activity to show.

4. After, it should look like this! 

► Pro Tip:  Teacher Text is read-only for the student.

        Your Task: Complete the “Teacher Text” exercise on       Page 12  of your TeacherMade Sampler.

Ctrl-D ☑

https://docs.google.com/presentation/d/1QV3vWIF4UVvy81Qf1F3FZo20X7un72yThOOrrKhaU5M/edit#slide=id.ge4e6e7d7a5_0_0


⭐Tricks and Tips to Use When Creating Your Interactive Worksheet⭐
Like any new app, creating assignments on TeacherMade.com will take a little getting used to. However, your ease in using 
TeacherMade will quickly increase as you learn, and soon you’ll be a master! To help you on your journey, we are sharing 
some of our favorite tips and tricks here.

         Section 6: Shortcuts and Tips

Shortcut and Tips

Ctrl + D to Duplicate Any Object Zoom Buttons Set Default Border Color  

Press Space Bar to Keep Using the 
Last Tool

Add Blank Space Set Default Score 

Draw, Highlighter, Drawing Eraser Printing your Blank Interactivity Set Special Characters

Snipping Tool Change the Background of your 
Interactivity

Help 

Preview What Your Students Will See Slides



⭐Ctrl + D to Duplicate Any Object ⭐
★ Ctrl + D Video: Click Here

Use the duplicate feature to quickly duplicate any feature you’ve added to the worksheet.

Want to duplicate an answer box or any other object you’ve added to your worksheet? 
1. Click on the object to highlight it.
2. Select Control + D.
3. Drag this new object wherever you want. 

►Pro Tip: When you duplicate an item, the answer choices and point values you’ve added are also duplicated.

Use this as follows to increase your efficiency:
● If you have a series of similar answer boxes to create, set up the first box exactly how you want it.
● Then use Ctrl-D to duplicate as many boxes as you need.

This is a huge time-saver!

   Your Task: Complete the “Ctrl + D”  exercise on       Page 13 of your TeacherMade Sampler.

Ctrl-D 
☑

https://docs.google.com/presentation/d/1sn0kBrutE9DFEvJVTc6JdQEnp12k5H2W6R8nxtMD51U/edit#slide=id.p


⭐Press Space Bar to Keep Using the Last Tool⭐
★ Space Bar Video: Click Here

Use the spacebar shortcut to automatically reset to the last tool that was used to create a new object. Then you can quickly create a new 
object of that type.

Want to continue using the same tool to draw more boxes without having to select it each time?  
1. After using any tool, press the spacebar to keep working with it.

● You will notice that the toolbar will change: 

2. Click down on your activity, and add another tool/object.

►Pro Tip: 
● This is especially useful when adding answer boxes of different sizes.
● Pressing the spacebar also works after closing an “Edit Tool” window.
● As an alternate to Control + D, using the spacebar to keep working with the same tool is the best way to work when making 

different-sized objects

Your Task: Complete the “Space Bar” exercise on        Page 14 of your TeacherMade Sampler.

Spacebar

https://docs.google.com/presentation/d/11bslwg_TEt9GsErhTegDM5bSiVEjyTTSJZNMoZdGeDQ/edit#slide=id.p


⭐Preview What Your Students Will See⭐
★ Preview Video: Click Here

The “Preview” tool is absolutely essential so you can see exactly what your students will see when they open their assignment.

Want to “Preview” your activity?  
1. Click on the far left icon on your toolbar that looks like this.

(Note: You can also select “Preview” under the “View” menu on
the menu bar)

2. A new window will open up showing the student’s view of
the activity.

3. It will look like this! 

► Once in the “Preview” mode, you will be able to:
● Answer each question in your assignment.
● Test out hyperlinks.
● Listen to audio.
● Check your answers.

      ►Pro Tip:  Many Teachers have used the “Preview” mode along with screen recording software to create a video showing their
students how to use the different tools in the “Student” view of the assignment. 

Your Task: Complete the “Preview” exercise on       Page 14 of your TeacherMade Sampler.

https://docs.google.com/presentation/d/1f3Cj_OUp5dtMUaBYmIT7ymEKsjbU3dBMP1w0O37E1I8/edit#slide=id.p


⭐Draw, Highlighter, Drawing Eraser⭐
★ Draw, Highlighter, & Eraser Tool Video: Click Here

How do you use the Draw Tool? 
The Draw Tool is represented by the pencil icon on the toolbar. Use this tool to circle important information, add notes, and point your students 
in the right direction!
Note: Your drawings will be read-only for your students.

1. Click on the “Draw” tool on the toolbar. 
2. Select the “Draw Mode” you would like to use: 

★Freehand ★Lines ★Circle ★Rectangles
3. Select the Line Color and Pencil Width. You are ready to draw! 

How do you use the Highlighter Tool? 
Use this tool to highlight important information and bring attention to parts of the assignment you want to be sure your students notice.

1. Click on the “Highlighter” tool on the toolbar.
2. Choose the color of your highlighter. Start highlighting! 

How do you use the Erase Drawing & Highlights Tool? 
This tool is represented by the eraser on the right side of your toolbar. It can be used to erase drawings or highlights you’ve made on the 
assignment. 

1. Click on the “Erase Drawing” tool on the toolbar. 
2. Click on the drawing, shape, or highlighted area you would like to erase. 

 Your Task: Complete the “Draw, Highlighter, Drawing Eraser” exercise on       Page 15 of your TeacherMade Sampler.



⭐Snipping Tool⭐
★ Snipping Tool Video: Click Here

This powerful tool allows you to digitally cut out static objects on your screen and make them moveable-- aka "draggable."

How do you use the Snipping Tool? 
1. Click on the “Snipping” tool on your toolbar. 

Note: It looks like scissors. 
2. Your pointer will change to crosshairs.
3. Click and drag over the area you want to “snip.”

● The snipping tool will create an image from it and insert a color block behind it to cover the original image. 
● Click on the snipped image and press the “Delete” key if you want to erase the snipped image. You will see the color block.
● You can edit the color of the color block, resize it, or delete it to return to the original background.

4. It will look like this. 

►Pro Tip: You can use this tool to: 
● Create a draggable object. 
● Delete parts of your original worksheet or block it from your students view. 
● Move parts of your original PDF anywhere on the worksheet.
● Copy objects from other TeacherMade activities into your current one. 

   Your Task: Complete the “Snipping Tool” exercise on       Page 15 of your TeacherMade Sampler.



⭐Zoom Buttons⭐
★ Zoom Buttons Video: Click Here

Are you tired of squinting at the words you’re typing onto the assignment? Use the “Zoom” tools to get a better look at what you're typing. 

 Want to Zoom in on your assignment?  
1. Click            the “Zoom” button on your toolbar. 

2. This dropdown will appear. 
3. You can choose to Zoom in or Zoom out. 

You can also:
1. Select “View” on the menu bar. 
2. Then select “Zoom” to access the dropdown. 

      
  ►Pro Tip:  Use the keyboard commands Crtl+Alt++ to Zoom In and Crtl+Alt+- to Zoom Out easily. 

  Your Task: Complete the “Zoom Buttons” exercise on       Page 16  of your TeacherMade Sampler.

https://docs.google.com/presentation/d/1wo6IPTol71qFxwOYoQFGTMdMKPe9qv23DAhbxfWs_Ic/edit#slide=id.p


⭐Add Blank Space⭐
★ Add Blank Space Video: Click Here

This is only available when creating a Scrolling Activity.
You can also add blank space to the end of your interactivities if you need more room! 

You can choose between a ¼ inch, ½ inch, 1 inch, quarter page, half page, and a full page.

 How do you add a blank space?  
1. Click on the File menu and select “Add Blank Space.” 
2. Choose the amount of blank space you would like to add.
3. It will be added to the end of your interactive worksheet.

      

      ►Pro Tip:  You can select “Add Blank Space” repeatedly to continue adding blank space.

Your Task: Complete the ‘Add Blank Spaces’ exercise on       Page 17 of your TeacherMade.

https://docs.google.com/presentation/d/1v766NFi6iUZhLr6n-kM0Hkx_lye2ZLl4djzjK62T3XU/edit#slide=id.p


⭐Printing Your Blank Interactivity⭐
★ Print Video: Click Here

Is one of your students unable to get online, or forgot their computer at home? You can print your activity for the student to complete. 

 How to print your activity:  
1. Click on “File” on the menu bar. 
2. Select “Print to PDF.”
3. The “Print Activity” pop-up will appear. 
4. Choose the “Page orientation” and “Page size,” then click “Create PDF.”

5. Download the PDF to print it.

      ►Pro Tip:  These will be blank interactivities; student responses will not be printed. 
.

Your Task: Complete the “Print” exercise on       Page 17  of your TeacherMade Sampler.



⭐Change The Background of Your Interactivity⭐
★ Change Background Video: Click Here
      This is only available when creating a Scrolling Activity.

You can change the background (PDF) of your interactive worksheet at any time before you assign it to your students. The “background” 
is simply our word for the original document you loaded into TeacherMade before you added your interactives. Using the “Change 
Background” feature, you can switch this document to a different one and any TeacherMade tools you already used will remain on the 
interactive layer. Use this feature when you need to edit or update your original due to a mistake on the original or some other change you 
wish to make.

 To change your background:  
1. Choose “File” from the menu bar.
2. Then choose the “Change Background” option.
3. TeacherMade will prompt you to select the new file to use for your 

new background.
4. Upload your file.
5. The new background will appear behind the interactive tools you have

already entered.
(Note: You may need to adjust the tools’ positions if you shifted 
anything in the new background).

https://docs.google.com/presentation/d/1xHnmdws4f6Rizb4RbK5OO7GLjdYOFFN6YpAIbLdH3M0/edit#slide=id.p


⭐Slides⭐
★ Slides Video: Click Here

This is only available when creating a Slide activity. On the menu bar of the “Edit Activity” screen you will find the “Slides” menu. Here 
you can add, rearrange, resize, and delete your slides. 

 How to edit your Slides:  
1. Click on “Slides” on the menu bar.
2. The drop-down menu will appear.
3. In this menu, you can:

● New Blank Slide: A new slide will be added to your slide deck.
● Create Slide(s) from a File: The “Choose Background” screen will appear, enabling you to

upload a file to add to your slide deck.
● Reposition slides in your slide deck:

○ Move Slide Up/Down in the slide deck’s sequence.
○ Move Slide to Beginning/End of the slide deck.

● Change Slide Background: The “Choose Background for current Slide” screen will appear.
● Duplicate Slide: This will make a copy of the current slide.
● Resize Slide: The “Resize Slide” screen enables you to enter a new height and width.
● Transform Background: You can flip your slide vertically or horizontally, and/or

rotate your slide 90 degrees clockwise, counterclockwise, or 180 degrees.
● Delete Slide: The current slide will be deleted from your slide deck.

Your Task: Complete the “Slides” exercise on       Page 18 of your TeacherMade Sampler.



⭐Set a Default Border Color⭐
★ Default Border:

You can add a default border color so that all of your displayed tools look similar on
your activity. 

 How do you add a default border?  
1. Select the “Format” menu from the menu bar.
2. Then select “Set Default Border.”
3. Choose the border color. 

Note: If you already added tools to the page, select the “Update All Borders” option to set
them all with one click!

4. After setting the default border, any tool you add to your activity will have that border
until you change it.

   ►Pro Tip: You can set the default border to “No Border” if you do not want any borders to appear on any of the tools you add.

Your Task: Complete the “Set a Default Border Color” exercise on       Page 18  of your TeacherMade Sampler.



⭐Set a Default Score⭐
★ Default Score Video: Click Here

You can also set a default score! This tool is great if you have a worksheet where each question will be worth the same amount. 

 How to set a default score?  
1. Select the “Settings” menu from the menu bar.
2. Then select the option “Set Default Score.”
3. Choose the desired score. 

      

      ►Pro Tip:  Note: If you have already added the questions, select “Update All Scores”
              to set all of the scores to the default.

Your Task: Complete the “Set a Default Score” exercise on       Page 19  of your TeacherMade Sampler.

https://docs.google.com/presentation/d/1KwduH76LPjy1YQD1BRtoRXx3FhBku0B2oq75_oQIvks/edit#slide=id.p


⭐Select Special Character Sets⭐
★ Select Special Character Sets Video: Click Here

While TeacherMade’s default language is English, you can enable other character sets for you and your students to use. There is a full 
suite of characters, accents, and diacritical marks to support many languages!

 How to print your activity:  
1. Click on “Settings” on the menu bar. 
2. Next, click on “Special Characters.”
3. The “Select special character sets for students” box will open. 
4. Choose the character sets you want to allow students to use when entering text into the

short or open answer items or text boxes. 

5. This is what your students will see:

 ►Pro Tip:  If you select more than one character set, the characters sets you selected will be combined into one set. 
.

Your Task: Complete the “Select Special Character Sets” exercise on       Page 19 of your TeacherMade Sampler.



⭐Help⭐ 
★ Help Video: Click Here

On the menu bar of the “Edit Activity” screen you will find the “Help” menu. You can find more detailed help on each tool and access the 
videos you have been using in this training. 

 If you have any questions while working in the “Edit Activity” screen:  
1. Click on “Help” on the menu bar.
2. The drop down menu will appear.
3. Select the area in which you need assistance.

● Overview
● Editor Section in the Help Center 
● Guided Tour - General 
● Guided Tour - How to add Questions and Content
● Help with current..
● More (which will load videos of all of the tools listed)

      
►Pro Tip:  If you need more assistance, visit TeacherMade’s Help Center

      
      Your Task: Complete the “Help” exercise on       Page 19 of your TeacherMade Sampler.

Bonus exercise: Explore TeacherMade’s Help Center.

https://docs.google.com/presentation/d/1TQCKdTYiMfH9OaPYbjCuzzZBynyMeaiGjxS9uh3hJwM/edit#slide=id.p
https://support.teachermade.com/support/home


Work Smarter, Not Harder.

⭐Share Your Interactive Worksheets with Other Teachers!⭐
Have you made some great digital worksheets and other interactivities that you wish you could give to your colleagues so they 

could use them in their classrooms, too? Well, you can in TeacherMade!

Sharing assignments on TeacherMade is even easier than walking them down the hall. ;)

         Section 7: Sharing Your TeacherMades!

There are two ways to share your TeacherMades:

1. By providing them a link to a specific assignment. 

2. By adding a Co-Teacher to your account so they can access all of your activities. 



⭐How Do You Share a TeacherMade Interactivity?⭐
★ Sharing a TeacherMade Activity Video: Click Here

 How do you share a TeacherMade Worksheet?  
1. Go to the “My Worksheets” screen (where your folders are located).
2. Find the interactive worksheet that you would like to share.
3. Click on the three dots to the right of its name.
4. A submenu will appear.
5. Select “Sharing” from the submenu. You will see this pop-up message.
6. Toggle “Off” to “On” at the bottom where it says “Sharing for this activity is currently.” 
7. Doing so will cause the screen to update with a shareable link.

8. Click the “Copy” button to copy the link to your clipboard.
9. Email the link to any Teacher with whom you would like to share the assignment.

*Sharing interactive worksheets is super-easy and safe. The recipient of the link can view the activity, but they must make a copy of your 
shared activity before they can use it or edit it. You never have to worry that they will alter your original worksheet or affect your account in 
any way. 

https://docs.google.com/presentation/d/1Z6I_PS8PBhvtjVubBpYebK1oK8q0kuYpap2dkH4OA0I/edit#slide=id.p


⭐What Will the Other Teacher See When You Share a Interactivity?⭐
★ What Will the Other Teacher See Video: Click Here

 How will the  shared worksheet look to the other Teacher?  

1. When they open their email and click on the link, their own “My Worksheets” page will open. 
2. They will be presented with a “Preview” mode version of the worksheet.
3. When they click the “Make a Copy” button on the right, they will be able to use their own copy of the interactivity you

shared with them.

► It’s important to know:
● No one has access to your original version

of the worksheet except you.
● They can only make changes to their copy

 and assign it to their students.

Your Task: Make a copy of this TeacherMade interactivity we shared with you!
https://app.teachermade.com/s/gFJMpERyTY-SavOJqNwapg/

https://app.teachermade.com/s/gFJMpERyTY-SavOJqNwapg/


⭐How Do You Add a Co-Teacher?⭐
★ Adding a Co-Teacher Video: Click Here

The “Co-Teachers” feature enables you to add trusted colleagues to your TeacherMade account so they can view your work, or even have 
full access to your account. You control the level of access they have.

 How do you add a Co-Teacher to your account?  
1. Login to your TeacherMade account and select your icon in the upper right corner.
2. In the menu that appears, choose, “Co-Teacher Settings.”
3. You will see a window that looks like this:

 

4. The left side lists Co-Teachers that you have already granted access to your account and users that have given you Co-Teacher 
access to their accounts.

5. To invite a Co-Teacher to your account, enter their email in the box to the right under “Email.”



⭐How Do You Add a Co-Teacher? (Continued)⭐
 There are two “Permissions” to choose from when adding an email:  

A. “Read-Only:” Giving a colleague this permission will allow them to see your account in its entirety but will prevent them from editing, 
deleting, or changing anything in your account. This is great for sharing students’ grades and work with Co-Teachers, Intervention 
Specialists, or even Administrators. 

B. “Full-Access:” This option is exactly as it sounds. The Co-Teachers you add will be able to do everything you can do within your 
account. They will be able to edit scores, create worksheets, and even assign work to students. The “Full-Access” option is perfect for 
Co-Teachers, Paraprofessionals, and even long-term substitutes! The options are endless.

*Please note that this feature does not merge or connect your account with another Teacher. Instead, they will have the option to enter your 
account as a guest. Any work or edits they make while they are in your account will be saved to your account. When they are done, they will 
need to return to their own account. 

6. Once you choose to “Send” an invite, you will see the email in the “Users who have access to your account” list with a “Pending” label. 
You will need to contact each Co-Teacher directly to notify them to log into TeacherMade and accept your invite.

7. Once they accept your invite, the list will update to show this:

8. You can remove Co-Teachers from your Co-Teachers list at any time by choosing “Remove”. If you want to change a
colleague's permissions from “Read-Only” to “Full-Access” or vice versa, click on the edit icon next to the current 
permission level and select the other permission.

 



⭐Thank You for the Opportunity to Share TeacherMade with You Today! ⭐
We hope you have enjoyed your time with TeacherMade today. We love hearing from our TeacherMaders so let us know what 
you think of this training presentation, or anything else about TeacherMade. We strive to continuously improve and we can’t do it 
without the help of generous TeacherMaders like you!

Now that you are on your way to being a real TeacherMade pro, try uploading your own favorite activity and make it a truly 
interactive experience for your students!

         Section 8: Thank you! 

https://drive.google.com/file/d/1jG-vIN81B9cCAjMr4a0OyBevZQvWBU10/view
https://drive.google.com/file/d/1jG-vIN81B9cCAjMr4a0OyBevZQvWBU10/view


⭐Let’s Stay in Touch!⭐
★ Remember, if you ever have any questions or suggestions, you can contact customer support in our Community Forum 

found on the My Worksheets screen.

★ Be sure to check out all the videos on our YouTube channel and subscribe to get alerts when new videos are posted:  
https://www.youtube.com/c/TeacherMade/videos

★ You can also find TeacherMade on:
Facebook: @MyTeacherMade
Twitter: @MyTeachermade
Instagram: @TeacherMade
Pinterest: @Teacher_Made

Please Let Us Know How We Did By Sharing Your Feedback. Click Here 
To Take Our 1 Minute Survey. 

(We know you’re really busy, so we kept it short and sweet.)

Thank You, Teacher.

https://www.youtube.com/c/TeacherMade/videos
https://forms.gle/VunmWHAB5pnSq4719
https://forms.gle/VunmWHAB5pnSq4719
https://forms.gle/VunmWHAB5pnSq4719

